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Safety Instructions

Operate the Robot safely!
Always ensure personal safety of users and others while operating
aRobot or commissioning a robot celll In particular, no person

or obstructions may be present in the working area of the Robot.

In its basic version the Robot Controller package does not contain safety related
functionality. Depending on the application, these may need to be added.

See “CE marking”below and Section 5.

CE marking: Gantry Robot and the Robot Controller are a part of one system, which must
be risk assessed in its entirety and comply with the current safety regulations to ensure
personal safety. Depending on the result of the assessment further safety components
must be integrated. These are usually safety relays and door switches. Responsible is the
commissioning engineer of the system.

The Robot Controller contains a 24 V power supply unit that itself requires mains voltage
(120 / 240 V), depending on the configuration. Please check the label on the power supply.
Only qualified personnel may connect the power supply to the mains and put it into
operation.

Work on the robot electronics should only be carried out by qualified personnel. Check
current electrostatic discharge (ESD) guidelines.

Always disconnect the Robot Controller from the mains (120 / 240 V) when working in the
Control Cabinet or any electronics connected to the Robot Controller.

Do NOT hot-plug! It may cause permanent damage to the motor modules. Do not install or
remove any modules or plug/unplug connectors (e.g. Operating Panel, Emergency Stop
Button, DIO Modules or external relays, motor connectors) while powered on.

The Gantry Robot must be set up on a sturdy surface and bolted down or otherwise
secured.

Only use and store the systemin a dry and clean environment.
Only use the system at room temperature (15° to 32°C).

The ventilation of the system must be able to operate without hindrance, to ensure
sufficient airflow to cool the Stepper Motor Driver Modules. There must be at least 10 cm
of space next to the fan of the Robot Controller. The fan must, ideally, point upwards or to
the side (reduced efficiency). The fan must not point down.

Backup important data prior to installing the igus® Robot Control software.



2. Quick Start Guide

21.  Setupand Connections

o Follow Safety Instructions, Section 1.

e Make sure that the on/off switch on the Control Cabinet is set to "off".

e Mount the assembled gantry on a suitable base. Make sure that there is no tension on the
cables and that the sheet-metal reference plate of Axis 1is not bent.

Feed the cables through the large circular hole in the Control Cabinet and plug them into the
Stepper Modules. Each motor is connected to its Stepper Module via 4 connectors. All
connectors are labeled and coded to aid this process (see Section 4):

e Motor cable

e Encoder cable with 2 connectors L

e Reference sensor (End-Stop)

"
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Connect also the shield- and ground-
connections of the encoder and motor

cables with ground: Ja ; o)
e Motor ground: yellow-green B ; X
e Encodershield: black

Connect these 6 wires in the ground

connector block on the right side of the

electronic modules.

e Secure the robot cables against
tension, e.g. with a cable tie to one
of the holes in the Control Cabinet.
If available, plugin the display cable and secure it via the screw connection.

—

e After that the control can be connected to the mains.

2.2.  Switchingon

e Switch on the Robot using the on/off switch on the Control Cabinet.
o Thegreen light-emitting diodes (LEDs) on the modules are now on, also most red LEDs and
potentially some of the yellow LEDs.



23.

The green LEDs will start flashing after approx. 20 s.
This shows communication, now the Robot Controller is
up and running. If available, you can now move the Robot
using the Operating Panel (optional) in the “Jog" tab.
Details can be found in Section 8.

Connect your PC to the Robot Controller via an Ethernet
cable. Use the Ethernet port located directly next to the
USB socket on the embedded computer of the Robot
Controller.

Set the IP address of the PC to:

static192.168.3.1 with subnet mask of 255.255.255.0

2.4. Connect and Move the Robot

Install the igus® Robot Control software on your PC, see
Section 6.1.
Start the igus® Robot Control software. On Start-up you
can choose the project suitable for your Robot. Please
refer to the igus product number, the project names are
based on these.
You can now activate the Robot by pressing:

o "Connect’,

o “Reset"and

o “Enable”insequence.
Now the "Status” indicator on the left should be green,
status “No Error”.
You can now move the joints of the robot using the
buttons in the “Jog" tab.
Referencing is mandatory prior to moving in cartesian
coordinates or executing a program.

For details, please refer to Section 7.

Preparation to connect to your Window PC
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3. Introduction

3.1 System Overview

The robot system consists of four basic components:
1. Gantry Robot : the mechanical linear guides with motors and ref switches;
2. Robot Controller : Support Module, Steppermotor Driver and DIO Modules;
3. Robot Control Software: control software to execute robot programs;
4.  Programming Environment: graphical software to set up robot programs.

The system configuration uses an Embedded Computer with Robot Control Software to run
the Modular Robot Controller. This set up can execute robot programs without an external
Windows PC connected. For programming an external PC can be connected via Ethernet.

Programming Robot Control Motor Electronics Gantry Robot

Connected
via Ethernet

Embedded Computer Stepper and Gantry

iRC on Windows PC with Operating Panel Digital 10 Modules

Figure 3.1: Gantry with Embedded Computer running the Robot Control Software.

For educational environments the robot controller can be directly commanded by the Windows
PCusing a USB-to-CAN adapter. This set up is not covered here.



3.2.  Glossary and Abbreviations
Name Abbrev. Description
igus® Gantry Gantry Mechanical robot
Robot or including structure,
Robot motors and cables
Modular Robot | Robot Consists of:
Controller Controller | e 1Support
Module
e 3ormore
Stepper Modules

¢ 1-3DIO Modules

Control Cabinet

Steel cabinet that
the Robot
Controller canbe
mounted in.
Includesa24V/
10 A power supply.

Embedded
Computer

Optional
Embedded
Computer with
Linux operating
systemand the
TinyCtrl Robot
Control Software

Operating
Panel

Optional operating
hand-held device
with 3.5" capacitive
touchscreen
display and 3-axis
joystick




Electronic Control Modules

Emergency - Single-channel
Stop Button emergency stop
Digital DIO Reads 7 digital
Input/Output Module inputson24V level.
Module Sets 7 digital
output channels
based on Solid
State Relays.
Steppermotor | Stepper Versions:
Driver Module Module ¢ Motor Encoder
(ME):
- high current (HC)
-low current (LC)

¢ Output Encoder
(AE):

- high current (HC)

-low current (LC)

Support
Module

10

Provides 5V logic
voltage, max. 2 A.
Interface for single-
channel Emergency
Stop Button.
Interface for
additional e.g. dual
channel safety
relays.



3.3.  Specifications
Gantry Robot
Type igus® Gantry Robot
Number of axes depending on type
Payload depending on type
Modular Robot Controller
Power supply 24Vat10A
Type DIN rail modules ME format with 5-pin bus connector

Communication

Controller Area Network (CAN) Fieldbus 500 kBit
USB-to-CAN Adapter PCAN-USB from Peak Systems
Ethernet

Support Modules

Provision of 5V logic voltage: max. 2 A

SoftStart to prevent overloading the power supply
1-channel emergency stop function without safety
classification

Provision to connect external safety relays

Steppermotor Driver Modules
(Stepper Modules)

For operating a bipolar stepper motor with
quadrature encoder RS422
24 V reference switch input

Digital In/Out Modules
(DIO Module)

Embedded Computer (if included)

7 digital inputs,12-24 V, optocoupled
7 digital outputs, solid state relays, max. 500 mA

Platform

Phytec Regor or comparable
CPU e.g. Texas Instruments AM3352

Operating system Linux
Software TinyCtrl Robot Control Software
Interfaces Control of the drives and DIO Modules via the CAN bus

Connection to igus® Robot Control via Ethernet
RS232 display connection

Programming and Robot Control Software

igus® Robot Control (iRC)

Recommended System
requirements

3.4.

PCwith e.g. Intel i5 CPU (minimum i3) and Windows 10,
free USB 2.0 port, ethernet port, 500 MB disk space

Mechanical Dimensions

For more information see the igus® manual of the specific gantry.

n



4. Electrical Connections

4.1.  Overview

connect

L o OneraﬂngPanel

DOutz3 o] bout27 o
-=E D-In25 ; D-Out22 g D-Out26 £
2 H 2
)
[
B =
©
» o
K a
o End-Max S
© End-Min= & [
O o - .6 —
= O e [o]
v o ol c o
T ©o v o
o = - =
o — L
(] c o
R © £
[T P
-
C s 8%
g o
| = E
o — ENC-AN ]
o ENC-BN b
ENC-1 c
L J e
o
o

RS232 ribbon cadle

25 3k 3| 3

& [ @ 3
HEEH AL &l
5§15 £lg Sk g2
22k 5B =3

o FEx3

support module

chassis fan

module fan

D-Sub socket

To:

support module
chassis fan
module fan
D-Sub socket

AC neutral

Figure 4.1: Overview of electrical connections. The number of motor drivers depends on the number
of joints of the gantry.
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4.2.  Pinout: Stepper Module

Each Stepper Module drives abipolar stepper motor with Motor Encoders. The encoder signals
are evaluated by a line driver (RS422).

Signals to each axis travel via three cables: the motor cable, encoder cable and reference
switch cable.

The motor cable is connected to a plug labelled “Motor”, the encoder cable is connected to two
plugs labelled "ENC-1" and "ENC-2" and the reference switch cable is connected to the plug
labelled “End-Stop”.

Motor connector:
Connects a bipolar stepper motor.
Pin1(left): blue B

Pin2: white A
Pin 3: black B/
Pin 4: brown A/

Encoder connector1 (ENC-1):
Connects a quadrature encoder to aline driver.

Pin1(left):  white A

Pin 2: red 5VDC
Pin 3: green B

Pin 4: grey oV
Encoder connector 2 (ENC-2):

Connects a quadrature encoder to a line driver.
Pin1(left):  brown A-N

Pin 2: yellow B-N

Pin 3: blue index
Pin 4: pink index-N

All eight wires (encoder connectors 1and 2) must be
connected to read the encoder.

End-Stop connector:
Connects to an end-stop or reference switch.

Pin1(left):  brown 24V

Pin2: blue ground (GND)
Pin 3: black signal

Pin4 do not connect

13



43. Pinout: Support Module

The Support Module provides 5 V logic voltage, a single-channel emergency stop relay,
a SoftStartrelay. It feeds the signals into the DIN rail bus system.

Supply voltage connector:

Pin1(left): red 24V
Pin 2: black GND
Pin 3: do not connect -
Pin 4: do not connect -

Controller Area Network ( CAN) connector:
Connects controller and CAN-interface of Embedded

Computer.

Pin1(left) 5V to Embedded PC
Pin 2: black CAN-GND

Pin 3: orange CAN-L

Pin 4: red CAN-H

Emergency stop (E-Stop) connector:
Connects the Emergency Stop Button.

Pin1(left): blue E-Stop channel1
Pin 2: brown 24V output signal
Pin 3: black E-Stop channel 2
Pin 4: do not connect -

This is a single channel setup, adapt this to your
safety requirements! The options for connecting a
safety relay are described below and in Section 5.

Motor power bridge:

Allows the motor current to be interrupted by
external safety switches, see Section 5.
Pin1(left): motor power-out

Pin 2: do not connect
Pin 3: motor-power in
Pin 4: do not connect



4.4. Pinout: Digital Input/Output Module

The DIO Module provides input and output channels, e.g. to operate a gripper valve. The
outputs can switch up to 500 mA. The inputs use optocouplers and are compatible to input
Voltages between12and 24 V.

A circuit switched by the output relays must not contain any larger capacitors.
A If the current exceeds 500 mA, the solid-state relays can suffer damage.

For safety reasons, the inputs and outputs of the DIO Module are electrically isolated. This
means that the circuits of the inputs and outputs are not connected to the internal circuits of
the controller.

Itis, therefore, necessary to connect a supply voltage for the outputs and a ground line for the
inputs. For this purpose, the 24 V available in the robot controller can be used, but also an
external independent voltage source. In Software the inputs and outputs of the first
DIO Module are numbered 21-27; the second DIO Module (if supplied) has numbers 31-37; and
the third 41-47.

Digital Out connector A (D-out A):

The output relays connect the pin of the power
supply with the corresponding output pins.
Pin1(left): Inputvoltage (for all seven channels)

Pin 2: D-Out channel1(in software: Dout21)
Pin 3: D-Out channel 2 (in software: Dout22)
Pin 4: D-Out channel 3 (in software Dout23)

Digital Out connector B (D-out B):
The D-out B pins are (from left to right) the
Digital Out channels 4-7 (picture not shown).

Digital In connector A (D-in A):

Pin1of D-In Ais the corresponding GND pin for all
input pins.

Pin1(left): Signal GND (for all seven channels)

Pin 2: D-In channel 1 (in software DIn21)
Pin 3: D-In channel 2 (in software DIn22)
Pin 4: D-In channel 3 (in software Din23)

Digital In connector B (D-in B):
The D-in B pins are (from left to right) the Digital In
channels 4-7 (picture not shown).

15



45. Connect Sensors and Actors to the DIO Module

The easiest way to connect a programmable logic controller (PLC) is via digital inputs and
outputs. Each Robot Controller comes with one DIO Module. This provides 7 inputs and
7 outputs (see Section 4.4). If additional inputs and outputs are required, up to two additional
DIO Modules can be integrated, see Section 10.1. A total of up to 3 DIO Modules can be

controlled.

The outputs are controlled via solid state relays and can switch up to 500 mA. This value must
not be exceeded during the switching process (e.g. by charging currents of capacitors) to

prevent damage to the relays.
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Figure 4.2: Internal setup of a

The inputs and outputs are galvanically separated from the robot control. A power supply
(labelled “IO Supply” in the Figure above) must be connected. The integrated 24 V supply may

also be used.

16

ER N 2|9
g o glo
g|s g|s
8|~ 8l~
3~ ER LN
> >
DIO Module.




4.5.1.1.

4.51.2.

To Connect a Sensor

Pin1(GND) of the D-In1 connector must be connected to GND of the power supply of
the sensor.

The sensor signal (positive) must be connected to an input pin D-In T connector pins
2-4 or D-In 2 connector pins 1-4.the positive side of the sensor has to be connected to
VDD of the power supply.

The status of the inputs can be monitored in the "Input/Output” tab at the bottom of
iRC, see Section7.1.

In a robot program inputs can be queried and reacted upon e.g. in an if-then-else
command, see Section 0.

To Connect an Actor (LED, pneumatic valve, relay...)

Pin1(Supply) of the D-Out 1 connector mustbe connected to a power supply (e.g.24 V)
The actor (relay, etc) is then powered from a free pin of the D-Out connectors
(D-Out 1 pin 2-4 and D-Out 2 pin 1-4).

You can set the outputs manually in the “Input / Output” tab on the bottom of iRC, see
Section7.1.

In a robot program you can set the state of the outputs using the digital-out
command, see Section 8.6.
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Figure 4.3: Connection of an input and output to the DIO Module.
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4.6. Option: Control Cabinet

The Modular Robot Controller can be orderedin a steel cabinet. The cabinet shields the control
from dust, humidity and accidental access.

The dimensions of the control cabinet are W x L x H: 600 x 200 x 125 mm

Figure 4.4: Control Cabinet, closed. On the lower left the mains IEC connector / switch / fuse and
the cable fittings can be seen.

The cabinet includes a24 V /10 A power supply for 220V /110 V input. A fuse (8 A). Distribution
blocks are included. A small fan is mounted on the left side of the cabinet.

mﬁ;‘\
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Figure 4.5: Control Cabinet with Power Supply, without Modular Control Electronics.
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4.7. Option:Embedded Computer

An Embedded Computer can be combined with Modular Robot Controller, so that an external
computer is just required for programming, but not for day to day operation. This resembles
“Configuration A"in the introduction, Section 3.1.

The Embedded Computer is a single board computer with Linux operating system, running the

TinyCtrlrobot control software. It is used to:
e Operate the Gantry Robot
e Replay programs
e Connect with {RC on a Windows computer via Ethernet for programming.
The Embedded Computer communicates with the Modular Control Electronics on the DINrails.

Figure 4.6: Embedded Computer with Ethernet cable connected to the ETHO socket.

4.71. Ethernet Connection

ETHO Connection to PC for Standard Ethernet
Primary Ethernet Port programming via IP192.168.31
(next to the USB port) igus® Robot Control

ETH1 Usually none. Canbeusedto | Standard Ethernet
Secondary Ethernet Port | connect acamera IP192.168.4.1

4.7.2. Operating Panel Connection

An Operating Panel can be connected, see Section 4.8

RS232 connection RS232 connection to the Lead1: UART2-TX
Operating Panel Lead2: UART2-RX

19



Figure 4.7:D-Sub connector to the Oberating Panel.

The 2 leaded ribbon cable of the Embedded Computer is
the RS232 connection for the Operating Panel. One lead is
marked black (Lead 1).

Itis connected via a distribution block to a 9-pin D-Sub
connector.

Lead1(black) D-Sub conn. Orange

Lead?2 D-Sub conn. Brown

To provide power to the display, the black and red lead of
the D-Sub connector are connected to GND and 24 V
respectively.

The pinout of the connector is as follows:

Caution! The connection is proprietary.
Itis not suitable for a null modem cable or the like.

Pin1: 24V
Pin3: RS232-TX
Pin 6: GND

Pin7: RS232-RX
Allremaining pins are not connected

20



473. CAN Connection

CANribbon cable
(three conductors)

Establishes the CAN
connection to the Stepper
Modules. To be connected to
the Support Module

Lead1: GND (black)
Lead2: CAN-L
Lead3: CAN-H

4.7.4. Power Supply

respectively.

follows:
Lead1(black)
Lead2
Lead3

The 3leadedribbon cable of the Embedded Computer is
the CAN connection. It has one lead marked in black
(Lead 1, GND). Leads 2 and 3 are CAN-L and CAN-H

The leads are connected to the support board as

Support Board CAN Port Pin 2
Support Board CAN Port Pin 3
Support Board CAN Port Pin 4

Power supply 5V

Supplies the Linux Board
with5V DC

Pin1:
Pin 2:

5V
GND

The connector has a white (5 V) and a black (GND)
wire. When the module is mounted on the DIN rail,
white (5 V) is towards the bottom of the cabinet.
The 5V (white) cable is connected to the Support
Module 5V port (Pin 10of the CAN connector).

The black cable is connected to the power
common GND distribution blocks of the DIN rail.

Double check the polarity of the connection before switching on.
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4.8. Option: Operating Panel

The Operating Panel is used to control the Robot via the Embedded Computer. For operating
instructions see Section 9.

The connection of the D-Sub-9 connector is mating to the D-Sub-9 socket of the Control
Cabinet Section 4.7.2.

Figure 4.8: Operating Panel with touch screen and 3-axis joystick.
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5.  Safety

51 Safety-Related Features of the Modular Robot Controller

The Modular Control Electronics have provision for the connection of external safety
components. However, external safety relays/switches can be connected to interrupt motor
power. The emergency stop is a1channel device and does not comply to a safety integrity level
(SIL).

5.2.  CECertification

The components of this robot system are provided with CE marking as requested by the
European machinery directive. Responsible for the components are:

e igus GmbH: Gantry Robot

e  Commonplace Robotics GmbH: Modular Robot Controller.
These CE markings confirm the adherence of these parts of the final machine to the necessary
standards. The final machine, i.e. the complete robot cell, is not covered by these CE markings.

53. Integration of SIL-Rated Safety Components

The Modular Robot Controller does not provide any safety-relevant functions. The integrated
emergency stop function is single channel.

In order to operate the complete, customer-specific robot system, the
commissioning engineer must carry out a risk assessment as part of the
CE certification and, depending on the result, integrate additional safety

components. These are usually safety relays, fence and door switches.

Safety relays can be connected in series with the motor power bridge connector (Section 4.3)
of the Support Module (Figure 5.1). The connector is labelled “Ext Rel". Via this connector the
motor supply is routed out of the module and via a jumper lead back into the module and then
into the bus. If this connection is interrupted, no active movement of the motors is possible.
This enables the implementation of safety features with the SIL required by the application.

23



Safety
Component with

E-Stop SIL level
Signal
Support Module ‘g_
Motor
Power Out
24V Power L ‘
Supply Motor
Power In ‘

..to the Stepper Modules

Figure 5.1: Schematic wiring of the safety components with the Support Module.
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0. Software Installation

e Backup important data before installing the igus® Robot Control software.

e Beforeupdating the igus® Robot Control software, create a backup of the
current version, e.g. by renaming the folder C:\ iRC-igusRobotControl\ to
C:\iRC-igusRobotControl BAK\,

6.1.  Installation of the iRC-igus ® Robot Control

LOW ELELTT™
COST! '\ =&

AUTOMATION

Installer Language X
(‘;'f Please select a language.
3
English / English 9
Coc ] [ conce
(& igus Robot Control Setup — X
License —_
Please review the license terms before installing igus Robot Control, (;7

Press Page Down to see the rest of the agreement.

qus Robot Control - RC ~
V902-11
iint-robot-control@igus.net

(Copyright (¢) 2011 - 2020 Commonplace Robotics GmbH

[Safety during Usage of the Robot

--> The user guide and espedially the safety instructions have to be adhered

> The Commonplace Robotics robots are designed for indoor use. They do have to be
iprotected of humidity and dust

--> Children must not operate connected robots without the supervision of adults v

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install igus Robot Control.

(o= [ o

Insert the igus® Robot Control USB
memory stick. Start the installer:
D:\Installer_IRC_V11-nnn.exe

You may have to allow changes on
your system.

After starting the installation, you
have to choose between German and
English language.

Then confirm the license agreement.

25



(5 igus Robot Control Setup - X
Chooo kel Locition In the next step you can choose where
Choose the folder in which to install igus Robot Control. (D .
igus® Robot Control should be
e s s e o o it T ety installed. The recommended directory
is
C:\iRC-igusRobotControl

Destination Folder

J[E:SRC-iqusRobotControl] Browse... . . . .
When installing igus® Robot Control in
Space required: 200.0 MB . . .
Space avaabl: 6,868 a Windows program directory like

C:\Programs
it is possible that igus® Robot Control
can only be started as administrator.

<Back Cancel

@

okt Comptes S The installation usually only takes

Setup was completed successfully.
afew seconds.
Completed

Show details

Next >

(5 igus Robot Control Setup -
Completing igus Robot Control After finishing the installation, you can
Setty start igus® Robot Control.

igus Robot Control has been installed on your computer.

Click Finish to dose Setup.

OstartRc

Now you can start igus® Robot Control via the link on the desktop or via the start menu.

Installation error:

The installation wizard checks whether all necessary extensions are available, especially the
NET framework. If this is not the case, an error message appears. The NET framework must
be installed manually:

e Searchthe network for "Microsoft .NET download" and install it.
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6.2. Licensing

e Theigus®Robot Control software requires a license key to be started.

e Thiskey s installed automatically during the installation of igus® Robot Control.

¢ Please do not change the content of the license file, otherwise it will become invalid!

¢ Theincluded standard license allows the installation and use of igus® Robot Control on
any number of computers in the company or organization of the licensee.

6.3. Settingup the Ethernet Connection to the Embedded

Computer

o Connect the Ethernet port (ETHO, adjacent to the USB socket) of the Robot to a Windows

PCusingastandard LAN cable.

e SetthelPof the PCt0192.168.3.1 (the Robot has IP192.168.3.11). Further assistance on

how to change the IP address can be found online.

From this point on the igus® Robot Control programming environment can be used to operate

the connected Robot.

Internet Protocel Version 4 (TCP/IPv4) Properties
General

‘fou can get IP settings assigned automatically if your network supparts
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(@) Use the following IP address:

IP address: 192.168. 3 . 1
Subnet mask: PF§.255.255. 0

Obtain DNS server address automatically
(@) Use the following DS server addresses:
Preferred DNS server: l:l
Alternative DNS server: l:l

[ validate settings upon exit Advanced...

Conca
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6.4. Installing the CAN-to-USB Driver

When no Embedded Computer has been supplied, a CAN to USB adapter is supplied that
connects the Modular Robot Controller and a computer. It requires the appropriate driver. The
Robot Control Software is delivered with the PCAN-USB driver from www.peak-system.com,
which can also be found igus® Robot Control installation USB memory stick (directory PCAN-
USB-Adapter) or the installation CD of the manufacturer.
After starting the installation, you must:
e accept the license agreement,

and
e specify theinstallation folder.

In the next step, please check whether the PCAN-USB device and the PCAN-View CAN-Bus
Monitor are selected for installation as shown below.

.Jé“é PEAK OFM-Treber Insalltion (NN | I Choose both for the installation:

| Komponenten auswahlen o PCAN'USB
ahlen Sie die zu installierenden Komponenten. indem Sie in die .
entsprechenden Kastohen klicken. o PCAN'V[QW

Fiertetreiber fir The PCAN-View CAN-Bus Monitor
[¥] PCAN-USE, PCAN-USE Hub

[ PCAN-PCI, -cPCI, -miniPCl, -PCI-Erpress, -PC/104-Plus, ExpressCard a“OWS yOU tO CheCk Whether the
7] PCAN-PC Card adapteris correctly connected but s
[Tl FCANAISE Fio not required in day to day operation.

Software-Komponenten:

[¥] PCANView CAN-Bus Manitor

¢ Zuriick H “weiter » J IAbbrechen
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7. Moving the Robot withiRC

igus® Robot Control (iRC) is a control and programming environment for robots. The 3D user
interface should help to get the robot up and running quickly. Due to its modular design
different kinematics and motor drivers can be controlled.

These operating instructions are supplemented with the respective robot-specific operating
instructions.

71.  TheiRCGraphical User Interface

This section explains the igus® Robot Control software. Without the Robot connected all steps
can be simulated. In Section 7.2 the real Robot is then connected and moved.

The iRC programming environment allows control and programming of the Robot. iRC is a
Windows software. You can work both online and offline, i.e. with the robot or in simulation
(with the robot switched off or disconnected).

RC - igus® Robot Control - V902-11-005 - DLE-RG-0001.p1

e | Moton A

Speed | Type~
Motion paramete -

Figure 7.1:igus® Robot Control user interface.

In the upper left corner, the three tabs "File", "Scene" and "Motion" provide access to the main
function-sets. In the left corner, information about the current state of the physical Robot is
displayed. Additional functions such as loading another project ("Open project”) or "Reference
robot" can be found in the "File" tab (Figure 7.1).
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There are six tabs at the bottom of the window:

¢ "Logmessages": messages from the program about status or errors.

¢ "Infocenter": shows axis values, the cartesian position and further information.

o "Jogging" keys to move the Robot.

o "Input/Output”: display and set the DIO of the Robot Controller.

e "Programs & Variables": displays the current state of program variables.

¢ "Cameras": shows information on the current camera status, e.g. target positions.

The "Help" icon can be found in the bottom right corner and contains links to the
Wiki pages (related to "Online documentation”, "Software updates", "Examples”,
"Troubleshooting") and link to "Contact support”.

711.  Selecting the Robot Type

igus®Robot Control offers project-related settings for different types of Robots, such as 4- or
5S-axis Robots. Click on the "File" tab in the upper left corner and select "Open project” (Figure
7.2). Select Robot group e.g. "drylin-gantry”. Now click at the named image that fits your
specific Robot, e.g. DLE-RG-0001.

Open a project

jm‘ Current folder: Projects\drylin-gantry

& Confgure Proect

{23 Configure Robot

Recent projects:

DLE-RG-0003

Kl ]

Please select the project that you wish to load.

Figure 7.2: Selecting Robot type of the "File" tab in the "Open project”.

30



71.2.  Mouse: Navigation and Moving Robot in the User Interface

To navigate in the igus® Robot Control 3D environment, a 3-button mouse is recommended:
e Leftbutton:
o Selection of icons and features in the software ribbon.
o MovingaRobot axis: place cursor over ajoint (it will highlight), then click and move the
cursor up and down while holding down the left mouse button.
¢ Middle button/wheel:
o Navigation in the scene to turn the Robot: move the cursor while holding down the
middle mouse button.
o Mousewheel: zoom in/out to the current cursor position.
e Rightkey:pan

| Scene  Motion The function of the left mouse button can be changed in the

"Scene" tab under "Navigation" section, with movement options:
"Select”, "Pan", "Rotate”, "Zoom" and "Reset". To get back to the
initial starting point click "Reset".

|

i

- P |
% g

Select Pan Rotate Zoom Reset

7.2.  Connecting the Robot

7.21.  Connection to Hardware

Thereal Robot can be controlled like the simulated one, only the hardware has to be connected
first by clicking "Connect”, "Reset " and "Enable" icons in the "Physical robot" ribbon group in
the "Motion" tab (see Figure 7.3). After that the robot needs to be referenced.
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Scene  Motion

+

Connect| Resst Enable | Reference

4

Status

Mot connected

Figure 7.3: Icons for connecting to the hardware, resetting errors and enabling the motors;
referencingicon; and "Status" indicator.

1. "Connect": Establish connection to the hardware.

e This stepinitializes the USB CAN interface or the Ethernet connection.

e The"Status" indicator on the left side changes from grey to red.

e Several error messages are displayed below the "Status" indicator.

2. "Reset ":Reset the errors.

e Thiskeyisusedtoreset the error memories of the electronic modules of the Robot
Controller.

e Theaxis positions are transferred from the real Robot to the simulation
environment. The 3D visualization of the Robot should now correspond to the
current position of the real Robot.

This must be checked with every error reset! If the values do not
& match, areferencing must be performed, described in Section7.3.

e The "Status" indicator remains red. The error messages are deleted, only "Motors not
enabled" remains. If other error messages are displayed, try again and follow the
instructions in the Robot documentation.

3. "Enable": Activation of the motors.
e The "Status"indicator is now green.

72.2.  Moving the Robot

It is now possible to move the Robot with: jog buttons, a mouse in the user interface or
agamepad, see Sections 7.1.2and 7.4.

32



7.3.

The

Referencing the Gantry

o After startup the gantry needs to be referenced. Prior to referencing, the
axes of the gantry can only perform movements in "Joint" mode.

o Only after referencing the start of a program s allowed.

o Thereference status is displayed on the left side of iRC.

Stepper Modules store the motor position inan EEPROM.However, due to gravity or other

forces, the joints can move and drop while motor-power is off. In that case, the Stepper

Modules willno longer report the correct position to the software, because they were switched

off,

while the robot has moved. In order to synchronize the position between software, Stepper

Motor Module and Robot Axis, areferencing operation must be carried out.

731.  StepstoReferencing

1
2.
3.
4

Start the Robot Controller and igus® Robot Control.

Press the "Connect”, "Reset" and "Enable” buttons (Figure 7.3).

Move the 5% axis of the Robot close to the reference position.

Click on "Reference" icon (Figure 7.3) in the "Physical robot" ribbon group in the "Motion"
tab (or "Reference robot" via "File" tab) to open the referencing window.

Click the buttons to start referencing the axes, see Figure 7.4. Several joints can perform
the referencing in parallel.

You can also click on "Reference all", then the axes start referencing in a sequence
defined in the project file.

As soon as all joints have stopped, click "Reset" and "Enable". Now the Robot is fully
operational.

IRC - igus® Robot Controf - ¥902-11-005 - DLE-RG-000L.prj

Reference robot

Internal axis 1: disconnected

Intemnal axis 2: disconnected

Not connected

2Gili% b er Intemal axis 3: disconnectes

¢B Set Amp configuration

) Get Amp configuration

Figure 7.4: Referencing window.
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7.4.  Moving the Robot with Software Buttons or Gamepad

The Robot can be moved (or "jogged") manually while no program is running. The two main
controls can be found in "Motion" ribbon:

e "Motion parameters" section (to choose motion modes and speed with software buttons),
e "lInput" section (to connect to a gamepad).

mE X

Load Edit Clear

Program execution Execution state Current program |Em

Figure 7.5: Control icons for moving the Robot (marked in blue).

1. Software buttons allow to select "Motion Type", which include three modes and in each
case the movement speed can be changed between 0 and 100% (Figure 7.5):
o "Joint": Aclick on A1to A3 moves the corresponding robot axis (if available). E1-E3 move
the external joints. (Figure 7.6).
e "Base"(cartesian mode), the Robot moves in straight lines along the X, Y and Z axes of
the base coordinate system.
e "Tool" (cartesian mode), the Robot moves in X, Y and Z of the current tool coordinate

system.
Joints ) ) !Exlema! joints )
l. Al - | mm | Al + | | | n/a o I | 1 - | nfa El + '
| »- | womm [aas | [ ] we [ase |2 ] w 2. |
| A3 - | 20 mr | A3+ | | A | n/a | | E3 | nfa E3 = |

Flgure76 The software buttons for "Joint" movements in "Jogging" tab. In both cartesian modes,
the buttons changeto X, Y, Z, A,Band C.

2. Agamepad is potentially the most intuitive way to move the Robot. Figure 7.7 shows the
key assignments. By pressing "Connect Controller", igus® Robot Control connects to a
gamepad. If the connection was successful, an OK sign is displayed on the controller icon.
The device must be of the "Joystick" or "Gamepad" type. You can find further information
on establishing a connection in the "LogMessages" tab (on the bottom of the screen).
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Legend:

1. Change motion type

2. Change key assignments:
Switching between X, Y,Zand A, B, C
in Cartesian motion mode, or A1, 2,3
and A4, 5, 6 in Joint motion mode.

Figure 7.7:Key assignments of the Gamepad.

7.5.  StartingRobot Programs

The robot program must be loaded and started.

1. Load the program: click the "Load" folder icon in the "Current program" ribbon group of

the "Motion" tab and select a program, e.g. igus5DOF_TestMotion. xml

RC - igus® Robot Control - V902-11-005 - DLE-AG-0001 p

U 0o » Frogams 6 )
F——— D)
- foun: - yme
. ": 2 guntyTestamt 1022091835
= out L testDeltaaom!. 130220201501
- B | testDeltaMatrocxmi 130220201541
& ) testRobalinkarm! 0080191454
bog
o
Bt
s Bt
AL 1 e
l P
L | Le ! ¥
A
Ducam - [CPRopProgrm s Com_
1og mesoges loerer TR /Ot Progrms 8 Voris | Comr [C0toen 7] [aechn ]

Figure 7.8: Loading a new program (circled in blue).
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2. Adjust the speed-override:

-— i 20% sl

d} e Beforestartinganew program, set the speed to

éDecreasei Increase h;'llotion e.g 20%.
| Speed | speed Type- ® Beparticularly attentive during the first complete
fotion parameters program run and keep the Emergency Stop Button
ready.

3. Startthe program:

- - e Click the "Play"iconin the "Program execution"

EEF - ribbon group of the "Motion" tab.

Play S5top Pause Replay

Mode -
Program execution

4. Stop or pause the program:

o After pressing the "Pause” icon, the Robot can continue with the program by clicking
the "Play" icon again.

o After pressing the "Stop" icon, the program starts with the first command when the
"Play" icon is clicked again.

e The "Replay Mode" can be set to:
o Single (program stops after a single cycle).
o Repeat (program does not stop until "stop"” or "pause” is pressed).
o Step (program steps line-by-line. This is useful for debugging a program).

7.6.  Digital Inputs and Outputs

The easiest way to connect a programmable logic controller (PLC) is via digital inputs and
outputs. Each Robot Controller comes with one DIO Module. This provides 7 inputs and
7 outputs (see Section 4.4). If additional inputs and outputs are required, up to two additional
DIO Modules can be integrated, see Section 10.1. A total of up to 3 DIO Modules can be
controlled.

The state of the inputs and outputs can be monitored in the “Input/Output” section of iRC.
Both inputs and outputs can be set manually:
e Outputs can be set manually, when no program is running.
¢ Inputs can be set only in simulation when there is no robot connected. Hence one can
test the reaction of programs on different inputs in the absence of hardware.
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Global signals DIN-Rail module 1 - inputs -~ DIN-Rail module 1 - outputs

[l sig (G5igl) [ GSig (GSig2) | Testln (DIn21) [ Din (DIn22) [ TestOut (DOut21) ] DOut (DOWE22) =
[] asig (G5ig3) [ GSig (GSigd) 1Din(Dinz3)  [[] Din (DIn24) | DOut (DOut23) | DOUt (DOUt24)
[7] sig (G5igs) [ GSig (GSigh) 10In (DIn25)  [[] DIn (Din26) ; | DOut (DOut25) | DOut (DOUtZ6) |

:Log messages | Infocenter | Jogging | Input/Output | Programs & Variables | Cameras
Figure 7.9:"Input/Output” section of the iRC software (tab at the bottom of the window).

See Section 4.5 on how to set up the electrical connections and Section 10.1 on how to extend
the number of available digital Inputs / Outputs. It is also possible rename the different inputs
/ outputs.

The programming with digital Inputs / Outputs is shown in Sections 8.4 and 8.6.

7.7.  Software Interfaces

Various interfaces are available from the Robot Controller:

e PLCinterface for controlling the Robot via a PLC, in particular for starting and stopping
programs.

e Plug-in interface to integrate e.g. cameras. The plug-in then transmits target positions to
the Robot Controller.

¢ Container Runtime Interface (CRI) to enable further interaction. This interface can be used,
for example, to generate workpiece-specific programs from a database.

e ROS interface to integrate the Robot into the Robot Operating System (www.ros.org).

See Section 10 for the configuration of these interfaces.

7.8.  Updating the Software

Updates of the iRC software can be found on the igus LowCostAutomation website.

BackUp: Please rename your old iRC-igusRobotControl folder to e.g. C:\ iRC-igusRobotControl
_BAKbefore starting the installation. This way, you can switch back to the old versionin case of
doubt. The following has to be transferred from the previous installation:

e Thecreated robot programs;

¢ (Changes in the project or robot configurations.
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8.  Programming the Robot with iRC

igus® Robot Control allows the creation of robot programs. The type of programming is called
“Teach-In-Programming”, which works as follows:
1. Move the robot manually to the position youwant to record
2. Record the position and define how to reach this position (linear/joint motion)
3. Repeat these steps and in between add digital output commands or program flow
commands.

The integrated Program Editor is provided for setting up and editing these robot programs.

81.  TheProgram Editor

In the robot program each command consists of one line, e.g. “Joint Motion” or “Wait". Only
commands that direct the program flow are separated into several lines, e.g. “Loop” and
“EndLoop”. The Program Editor is opened with the “Edit" button in the “Motion" tab.

“Stene Motion
¥ 1 =2 4+ D>

Connect Res: e Reference Decrease Increase Motion  Play Stop Pause
Speed Speed  Type~

s Controller

Motion parameters Program executio

Current program  Em

Figure 81 Opening the Program Edltor with the Edlt" button.

Input

Then the following window opens, here with a short program:

i Program Editor O

File Edit Action Flow Special

s gantryTest

E o Start - iRC V902-11-005, igus Gantry (drylin-gantn\DLE-RG-0001), without gripper r|

||:| el Joint {constant: A1=0 mm, A2=0 mm, A3=0 mm, vel=100%, acc=40%, smoath=0%) .|:| |—||
|£| 2 Joint {constant: A1I=300 mm, A2=0 mm, A3=0 mm, vel=100%, acc=40%, smooth=0%) |_“_| |_|
@ 3 Joint {constant: A1=300 mm, A2=300 mm, A3=0 mm, vel=100%, acc=40%, smooth=0%) [—”— |R|
[2 4 Joint (constant AL=300 mm, A2=300 mm, A3=60 mm, vel=100%, acc=40%, smaoth=0%) |40 [5]
(45 5  Jaint (constant A1=0 mm, A2=0 mm, A3=0 mm, vel=1008, acc=40%, smooth=0%) [l (=)

Loaded file: CNRC-igusRobotControl\Data\Programs\gantryTest.xml

Figure 8.2: Program Editor with a short program.

The following sections show how to write programs with the Program Editor.
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8.1.1.

Changing the Command Sequence

To move the command down, click on“Move down”, on “Move up” to move up. It is also possible
to use the arrows on the right side of the commands.

+

0

el

Gt

2

3
4
5

Start - iRC V902-11-005, igus Gantry (drylii

1-gantry\DLE-RG-0001), without gripper

Joint (constant: A1=0 mm, A2=0 mm, A3= 0 mm, vel=100%, acc=40%, smooth=0%) 8| |8
Joint (constant: A1=300 mm, A2=0 mm, A 3=0 mm, vel=100%, acc=40%, smooth=0%) @8 8
Joint (--=-tr-tAl-200--—-A2-300 mm, A3=0 mp~ +al= 100 re— A0 smooth=0%) 2o %
Joint | * |Deselect A2=300 mm, A3=60n % |Deselect | smooth=0%)  |©/8] [
Joint ( @ |Expand =0 mm, A3= Omm,ve B |Expand oth=0%) @ ®

T |Moveup 2+ |Move up

¥ | Move down ¥ | Move down

— | Remove — |Remove

P | Start here P | Start here

O | Touch up! O |Touch up!

The Program Editor will prevent commands that would render the structure of a program
illegal. If moving of a command in a up or down is impossible, the respective buttons and menu
items will be greyed out.

8.1.2.

Touching up Commands

Certain commands require position constants as parameter. Often, it is desirable to use the
current position of the robot. Entering it by hand can take quite some time and is error-prone.
For such cases the possibility to “Touch up” the command is offered. You can do this by, either:

with the right mouse button:

> 0
hlel
> 2
> 3
> 4
> 5

Start
Joint
Joint (constant: A1=300
(constant: A1=300
(constant: A1=300

(constant: A1=0 m

Joint
Joint

Joint

®

1€ 21

I
()

selecting the command and then pressing Ctrl+T
clicking “Touch up! in the context menu that pops up when clicking on the header

- iRC V902-11-005, igus Gantry (drylin-gantry\DLE-RG-0001), without gripper
(constant: A1=0 m o

o n, vel=100%, acc=40%, smooth=0%) & R

Sect nm, vel=100%, acc=40%, smooth=0%) @8 1R

Expand 0 mm, vel=100%, acc=40%, smooth=0%) ¢/ (%
60 mm, vel=100%, acc=40%, smooth=0%) e R
n, vel=100%, acc=40%, smooth=0%) @ b3

Move down

Remove

Start here

Touch up!

This functionality is also found in the menu: “Edit"->"Touch up!”

The Program Editor will then replace the position constant in the command with the current
position of the Robot.
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813. Current Starting Command

It is possible to execute programs command-wise, or to pick a specific command as starting
point of a program for debugging purposes.

The command that will be executed first, next time the program is started, or - if the program
is currently running - the currently executed command is indicated in the Program Editor.

The subprogram that contains this command s designated by afilled black circle in front of the
Program Name:

File Edit Action Flow Special

Test_ProgDev\test_sub_01 | eTest_ProgDevitest_sub_subprog
= 0 Start - iRC V902-11-002-Beta, igus Gantry (igus-drylin\DLE-RG-0003), without gripper

The command itself is designated by afilled black circle in the header bar of the command:

[ > 0 Start - iRC V902-11-002-Beta, igus Gantry (igus-drylin\DLE-RG-0003), without gripper |
[ CEI | Joint (constant: A1=20 mm, A2=-10 mm, A3=10 mm, vel=50%, acc=40%, smooth=20%) 3| IR
[ o 2 Joint (constant: A1=20 mm, A2=10 mm, A3=10 mm, vel=50%, acc=40%, smooth=20%) @8 18

To choose a specific command as starting point for execution, click on“Start here” in the
context menu that pops up when clicking on the header with the right mouse button:

|Test_ProgDevtest sub 01| eTest_ProgDev\test_sub_subprog

> 0 Start - iRC V902-11-002-Beta, igus Gantry (igus-drylin\DLE-RG-0003), without gripper

1 Joint (constant: A1=10.mm_A2-0mm _A2=10 mm, vel=50%, acc=40%, smooth=20%) S| R
b 2 Sub (run Test_Prog % |Deselect xml’) & 3
Expand

Move down
Remove

Start here

GREIEEIC

Touch up!
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81.4. UndoandRedo

All changes made in the Program Editor can be undone / redone.

Toundo you can: Toredo apreviously undone change you can:

e PressCtrl+Z. e Press Ctrl+Y.

o Click on the menu item ¢ Click onthe menuitem
“Edit"->"Undo" (it will be greyed out if no "Edit"->"Redo” (it will be greyed out if no
changes have been performed so far). changes have been undone before).

File |Edit Action Flow Special vFiIe Edit ‘Adi°" Flow Special
Fetl 9 |undo  ctlez Lt Test| | st
=l < 1 o ¢ ‘Redo trl+Y §q-
o, . =
Lt =
3 | Cut Ctrl+ . 3 [Cut B
B [copy  Cuiec B [copy  cuc
@ @&
e
U |Touchup! Ctrl+T (9] [

82. Comments and Information in Programs

821. Program Information

The Program Editor will introduce the Start pseudo-command at the beginning of each
program. It does not represent a real command in the sense that it will not be executed in any
way. Its purpose is to display information about the current hardware, software and kinematic.
Itis not possible to move or remove it.

=/ o Start - iRC V902-11-002-Beta, igus Gantry (igus-drylin\DLE-RG-0003), without gripper

Information

Robot name: Kinematic:
Robot type: Protocol:
Gripper type: Software:

822. Descriptions

Any command of a program contains a description. It can be filled with any text and should be
used to describe what the intention behind the respective command is to other programmers.

Description

Moving the robot to its idle position]

A



823. Comments

The Comment command can be used to include pure descriptions into programs. It has no
effect on the robot during execution, its sole purpose is to provide a Description.

= 1 Comment - Put some comment here. <3
Description

Put some comment here.

Itis accessible in iRC's Program Editor through the menu entry “Special”->"Comment:
File Edit Action Flow Special
.<empty>‘ % | Variable definition »

> 0 Start - iRC| ¥ |Variable operation »

% | Plugin »

% |Comment
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83. Variables and Variable Access

Two types of variables are supported in programs for iRC and TinyCtrl:
e Number variables: these can be used to store integer or floating point numbers
e Position variables: these can be used to store Cartesian positions and joint
positions. Whether such a variable will be interpreted as cartesian position or joint
position depends on context.

83.1. UserVariables

It is possible to define user-variables with the Store command, which is accessible in iRC's
Program Editor through the menu entries under “Special™->"Variable definition".

File Edit Action Flow  Special

<empty> 4 ‘Variabledefmition » £ | position
& 0 Start -iRC| 7 | Variable operation » £ | Number
% | Plugin »
% |Comment
Itis possible to choose three types of Store operations:
e “Current position™
= 1 Store (initialize myPosVar with current position) 3
Parameters
Variable: | myPosVar Type: Current position ¥
Description

A position variable will be initialized with the cartesian and joint position that the
robot has when the command is being executed.

e  “Number constant™

=1 Store (initialize myNrVar with number 0) %
Parameters
Variable: | myNrVar Type: |Numeric constant ¥ | Value: 0.00 5
Description

4

Anumber variable will be initialized with the constant given under “Value”.
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e “Position constant™:
=l 1 Store (initialize myPosVar with position X=327 mm, Y=0 mm.... P4
Parameters

Variable: | myPosVar Type: |Position constant ¥

Cartesian position

X: | 3267 &{mm V: 00[S{mm Z | 2623[%{mm
A: | 180.001%1° B: 0.001%1 ° C: | 180.00(% °
Joint position
Al: 0.00
A4: | 80.00

A2: 1000/ ° A3: 00015 *
AS5: 0005 ° A6

External axes
El: E2: E3:

Description

A position variable will be initialized with the constants given under “Cartesian position”,“Joint
position” and “External axes”. Depending on the kinematic model of the current robot certain
axes may be unavailable.

The name of the variable can be set under “Variable”". If a variable with the same name has
already been defined its value and type will be overwritten. All variables are global, i.e. they will
also be accessible from subprograms.

83.2. System Variables

The following predefined variables are available without the need to define them:

e  #position
The current position of the robot. The units of the Cartesian position are mm for the
components X,Y,Z and degrees for the Euler angles AB,C. Joint values are measured in
mm or degrees, depending on the type of the joint.

Note that the system controls the values of predefined variables - they cannot be changed by

the program. The names of predefined variables always start with a“#".

83.3. ElementAccess

The following elements of the variables can be accessed with the “.” Operator:
e Position: X,Y,Z Eg: myvariable.x

¢ Rotation:A B, C Eg: myvariable.a

e Joints: A1, A2, A3, A4, A5, A6, E1,E2 E3 Eg: myvariable.a5
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83.4. Operations on Variables

Operations on variables can be performed by using the Math command, which is accessible in

{RC's Program Editor through the menu entries under “Special’->"Variable operation”.
File Edit Action Flow |Special
<empty> 2 ‘Variable definition »

& 0 Start -iRC| # | Variable operation ¥ £ |Set

% | Plugin ) * [Add

% | Comment = |Subtract
Multiply
Divide

Y NN WY

Modulus

“Operand 1" defines the first operand of the operation that is to be performed. It will also be
used to store the result of the operation. Only names of user-defined number variables or
components of user-defined position variables are allowed.

“Operand 2" defines the second operand of the operation. It can contain numeric constants,
names of number variables or components of position variables.

= 1 Math (add 10 to myPosVar.x) <4
Parameters
Operation: |Add Y Operand 1: | myPosVar.x Operand 2: |10
Description

The following operations are supported and can be chosen under “Operation™:
e Set:
This will set the first operand to the value of the second operand.
e Add:
This will increment the first operand by the value of the second operand.
e Subtract:
This will decrement the first operand by the value of the second operand.
e  Multiply:
This will multiply the first operand by the value of the second operand.
¢ Divide:
This will divide the first operand by the value of the second operand.
e  Modulus:
This will store the remainder of the division of the first operand by the second
operand into the first operand.
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83.5. Monitoring Variables

You can monitor the current values of all defined variables under iRC in the “Programs &
Variables" tab:

Programs Pasition variables

‘gantryTest

Number variables

[Foyes | 23|
— — { P ——

oo [p-o0c [c=1m000 | | [rmen) o]

#partsfai-I_I ‘_|

Log messages | Infocenter | Jogging ]npt.ﬁfOutput!' roc

WES| Cameras
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8.4. ExecutionFlow

8.41. Conditional Expressions

Conditional expressions can be used in if-then-else commands, conditional loops and as abort
conditions in motion commands. The conditional statements can be combinations of digital
inputs, global signals, Boolean operations and comparisons. Examples:

e DIn23 True, if digital input 23 is high

e DIn23 ANDIDIn27 True, if digital input 23 is high and digital input 27 is not high

e modelclass=31 True, if variable modelclass is 31

e mempos.x>350.0 True, if the x component of the position variable mempos is

higher then 350
The syntax of conditional statements is given by the following EBNF definition:
Expression =[""]<Boolean> | <BooleanOperator> <Boolean>}...
Boolean := <BooleanConstant> | <Expression> | "(" <Expression> ")" |

CompExpression | "(" <CompExpression> ")" | <Digitallnputs> |

“("<Digitallnputs>")"

BooleanOperator ="And"|"Or"

BooleanConstant ="True" | "False"

Digitallnputs :=<ChannelType> <Channelld>

ChannelType ="Din"|"GSig"

Channeld =an integer value

CompExpression =<CompValue><Comparator><CompValue>

CompValue :=<Variable> | <Number>

Variable := <NumberVariable> | <PositionComponent>

NumberVariable :=Name of a number variable

PositionComponent :=<PositionVariable>"." <Component>

PositionVariable =Name of a position variable

Component =Y AT B CT AT A2 | "A3" | "A4" | "AS" | “AB" | “ET"
|“E2"|"E3"

Number = Integer or Float number

Comparator =S ] S| "
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8.4.2. Stop

The Stop command stops the program execution.
=1 Stop ] b3

Description

Itis available through the menu entry “Flow"->"Stop”.

File Edit Action Flow Special

<empty> | B | Stop

0 start| Il |Pause k

% | Wait ’
% |Loop 4
£ | if..then..else
% | Subprogram
8.4.3. Pause
The Pause command pauses execution of the program. Execution can later be resumed by the
user.
=1 Pause XQJ
Description

Itis available through the menu entry “Flow"->"Pause”.

File Edit Action Flow  Special

| <empty> W | Stop

S 0 Start I |Pause

Wait >

If..then...else

4
4 Loop >
¥
4

Subprogram
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8.4.4. Wait

The Wait command allows the robot to wait for a fixed amount of time or until a conditional
statement evaluates to true. It is accessible though the menu entries under “Flow"->"Wait" in
iRC's Program Editor.

File Edit Action Flow Special

<empty> B | Stop
> 0 Start| Il |Pause a, igus Gantry (igus-¢
£ | wait ¥ £ | Timeout
% |Loop N % | Condition
% | if.then..else
% | Subprogram

The different modes can by chosen under “Type™:
e “Timeout™
This will cause the robot to wait for the time that is given under “Duration”.

= 1 Wait (wait for 1) x®
Parameters
Type: |Timeout ~ Duration: 10015 s
Description

o “Condition”:
This will case the robot to wait until the conditional statement given under

“Condition” evaluates to “True".
=l 1 Wait (wait until ‘True’) P4
Parameters

Type: Condition ¥ Expression: | True

Description
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8.45. If-then-else

The If command branches execution of the program depending on the value of a conditional
expression. It is accessible through the menu entry “Flow™If...then..else" in iRC's Program

Editor.

File Edit Action | Flow
<empty> u
& 0 Start| I
5
5
¥
4

Special
Stop

Pause

Wait »

Loop 4
If..then...else

Subprogram

The conditional expression given under “Condition” must match the syntax described in
Section Fehler! Verweisquelle konnte nicht gefunden werden. . The branch between “If" and
"Else” will be executed if it evaluates to true, the branch between “Else” and “EndIf" will be

executed otherwise.

= 1 If (if ‘True’)
Condition

True

Description

o 2
& 3

o 4
EE

Comment
Else

Comment
EndIf

- Branch executed if the conditional statemant evaluates to “True"

- Branch executed if the conditional statemant evaluates to “False"

50

A

®

@18 1%
htalhi
@8 X



8.4.6. Loops

The Loop command allows to define execution loops. It is possible to choose between the
following types of loops under “Type™:
e “Condition”
The loop will repeat until the conditional expression given under “Condition”
evaluates to “True”. It must follow the syntax described in Section Fehler!
Verweisquelle konnte nicht gefunden werden. .

=/ 1 Loop (repeat until True') 3 %
Type Condition
Condition ¥ True
Description
o 2 Comment - This branch will be executed until the loop condition evaluates to “True” ¢S] R
/& 3 EndlLoop <«

e “Counter”
The loop will repeat the number of times that is specified under “Count”.

= 1 Loop (repeat 10 times) 3 %]
Type Count
Counter ¥ 10 %
Description

(] - Comment - This branch will be executed the number of times specified under "Count”. |{*||&| |82
Il 3 EndLoop @

The loop command is accessible via the menu items “Flow"->"Loop"->"Condition” and “Flow"-
>"Loop"->"Counter”.

File Edit Action  Flow  Special
autoGen B | Stop
) Start| 11 | Pause a, igus Gantry (igus-
% | Wait »
% |Loop ¥ £ |Condition
% |if.then..else | £ |Counter
% | Subprogram % | Matrix
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8.4.7. MatrixLoops

The Matrix command is designed to execute loops that allow the robot to perform raster-
movements, for example for palletizing tasks. It can be accessed through the menu item
“Flow"->"Loop"->"Matrix".

File Edit Action Flow Special
autoGen W | Stop
) start| 11 | Pause 3, igus Gantry (igus-
£ | wait »
% |Loop ¥ £ | Condition
% |If.then..else £ |Counter
% | Subprogram % | Matrix

The illustration below shows the movement pattern that can be achieved by using the Matrix

command.
Position A Position B
X > > - X
— — —
x — - —
Position C

The position variables given as “Position A", “Position B" and “Position C" define the corners of
the area that will be covered by the matrix loop (see illustration above). The number of steps
that are to be made are given by “X (from A to B)” and Y (from A to C)". For example, in the
illustration above, X would be 4 and Y would be 3.
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&|
®

=l 1 Matrix (matrix 3x3, A:myPointA, B:myPointB, C:myPointC, targetmyMatrixPos, X:myCntX, Y:myCntY)

Dimension

X (from A to B): 3 % stops Y (from Ato C): 3 % stops

Corners

Position A: | myPointA Position B: | myPointB Position C: | myPointC

Variables

Target: | myMatrixPos Counter X: | myCntX Counter ¥: | myCntY

Description

| 2 Comment - This is the inner part of the loop and will be executed repetitively. ¢E R

l < 3  Matrix End & |

The block between “Matrix” and “Matrix End” will be executed for each step. The position
variable given to “Target” will contain the position of the current target point for the current
step. Row and column of the current step will be stored in the number variables given to
“Counter X" and “Counter Y" respectively.

8.4.8. Subprograms

The Sub command can be used to call subprograms.
I | Sub (run ‘filename.xml’) x
Filename

filename.xml Browse...

Description

The path to the file of the subprogram is given under “Filename”. It is relative to the Programs
subfolder of iRC's Data folder. The command can be accessed via the menu item
“Flow"->"Subprogram”.

File Edit Action Flow | Special

.autoGenr B | Stop

'4} 0 Start| I |Pause i

Wait 4

If..then...else

4
; Loop »
5
¥

Subprogram



85. Motion
8.5.1. AbortConditions

An abort condition can be given to any motion command. It is a conditional expression,
following the syntax described in Section 8.4.1. During the execution of the motion command
the statement is continuously evaluated, and the moment it evaluates to “True” the robot will
stop moving. It can be specified under “Abort condition” for each motion command

respectively:
Abort condition

False

85.2. Accelerationand Smoothing

In Motion commands joint accelerations can be defined, to prevent abrupt movement of the
robot. This can be done for a single motion command, but also for a combination of up to a
maximum of 10 commands. It is also possible to smooth out the corners within the path defined
by blocks of consecutive motion commands. This allows the robot to go through the corners
without coming to a full stop. If corner smoothing is set to 0% the robot stops at every corner
for a short moment. This leads to a more abrupt motion.

3\

N\

N

N

=
r

Any non-motion command will divide such a motion set and interrupt smoothing.
Parameters:
Acceleration: 40151 %  Smoothing: 20/ %
e “Acceleration”
Percentage of the maximally possible acceleration.
e “Smoothing"
Scope of the smoothing in percent.
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8.5.3. JointMotion

The Joint command moves the robot to a (absolute) target position given in joint coordinates.
The resulting motion of the tool center point (TCP) will typically be a curve and not a straight
line. The target position can be given in the following ways (choose corresponding “Source”):

e "Constant”:
The target position is a constant value for each axis.

=l 1 Joint (constant: A1=0.0°, A2=10.0°, A3=0.0°, A4=80.0°, A5=0.0°, vel=50%, acc=40%,... b4
Source Parameters
Constant ¥ Velocity: S01$| % Acceleration: A0 % Smoothing: 20 %
Constant
Axis1: | 000" Axis4: | 80.001%* Ext. axis 1:
Axis2: | 1000 (& ° Axis5: | 0001 * Ext. axis 2:
Axis3: | 000 ° Axis 6: Ext. axis 3:

Abort condition

False

Description

e “Variable"
The target position is taken from the position variable given to “Variable".

=/ 1 Joint (variable: var=myPosVar, vel=50%, acc=40%, smooth=20% ) x
Source Parameters
Variable ¥ Velocity: 5011 % Acceleration: 401 % Smoothing: 20r8 %
Variable
myPosVar

Abort condition

False

Description

The movement speed is given by “Velocity”. It is measured in percent of the maximally allowed
movement speed for the respective robot axes.
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The joint command can be accessed in iRC's Program Editor under the menu
“Action”->"Joint motion” and “Action"->"Variable motion"->"Joint".

File Edit Action Flow Special

'autoGen:;
@ 0| %

5
4
¥
5

Joint motion
Linear motion
Relative motion »

Variable motion »
Gripper

Digital output

8.5.4. Linear Motion

4

File Edit
IautoGen
> 0

|Action Flow Special
% | Joint motion
% | Linear motion 2-Beta, igus Gant
% |Relative motion »
% | Variable motion y £ | Joint

% | Gripper % | Linear

% | Digital output

entries

The Linear command moves the robot to an (absolute) target position given in Cartesian
coordinates. The resulting motion of the TCP will follow a straight line. The target position can
be given in the following ways (choose corresponding “Source”):

e “Constant™

The target position is a constant given by Cartesian coordinates X,Y,Z and Euler
Angles AB,C and positions of external axes if supported by the current robot

kinematic.

S| 1 Linear (constant: X=327 mm, Y=0 mm, Z=262 mm, A=180.0°, B=0.0°, C=180.0", vel=100... ] ]
Source Parameters
Constant ¥ ‘ Velocity: 100.0 % mm/s Acceleration: 40 —:— %  Smoothing: 20 —3 %
Constant
X: | 3267 mm A | 180.00 & Ext. axis 1:
Y: 00/&{mm B 0.00 & Ext. axis 2:
Z | 2623/ mm C: | 180.00 & Ext. axis 3:

False

Description

Abort condition
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e “Variable™
The target position is taken from the position variable given to “Variable".

=1 Linear (variable: var=myPosVar, vel=100 mm/s, acc=40%, smooth=20% ) R
Source Parameters

Variable ¥ | | Velocity: | 100.0[${ mm/s Acceleration: 40[$1 % Smoothing: 20 %
Variable

myPosVar

Abort condition

False

Description

The movement speed is given by “Velocity". It is measured in mm/s, if it exceeds the maximally
allowed movement speed of the robot it will cause a kinematic error during execution.

The Linear command can be accessed in the Program Editor under the menu entries
“Action"->"Linear motion" and “Action"->"Variable motion"->"Linear".

File Edit Action Flow Special File Edit Action Flow Special
autoGen | % |Joint motion ‘auﬁoGen % | Joint motion
&0 % | Linear motion 2 &0 ‘ % | Linear motion 2-Beta, igus Gan
% | Relative motion » % |Relative motion »
% | Variable motion » % |Variable motion » £ |Joint
% | Gripper % | Gripper % |Linear
% | Digital output % | Digital output

8.5.5. Relative Motion

The Relative command allows to move the robot relative to its current position. It can be
accessed via the menu items under “Action”->"Relative motion".
File Edit |Action Flow Special

autoGen % | Joint motion

& 0 | % |Linear motion 2-Beta, igus Gantry (igi

Relative motion ¥ 4 |Joint

Variable motion » # | Linear, base

4

Linear, tool

¥
5
4 Gripper
5

Digital output

The following modes of relative motion can be chosen under “Type":
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“Joint™:

Therelative offset is specified in joint coordinates. The movement speed is given by
“Velocity". It is measured in percent of the maximally allowed movement speed for
the respective robot axes.

=l 1 Relative (joint: A1=0.0°, A2=0.0°, A3=0.0°, A4=0.0°, A5=0.0°, vel=20%, acc=40%, smooth=20%) P4
Type Parameters

Joint ~ Velocity: 20% %  Acceleration: 40($1 % Smoothing: 2018 %
Offset

Axis1: | 0.00+8° Axis4: [ 000[%]* Ext. axis 1:
Ads2 [ 000/8]°  Akss: | 000/8]c  extoaxs2:
Axis 3: 0.00 - * Axis 6: n Ext. axis 3:

Abort condition

False

Description

“Linear - Base™:

A linear movement with an offset specified in Cartesian coordinates will be
performed. The coordinate system used for the offset is the robot coordinate
system. The speed is given by “Velocity”. It is measured in mm/s, if it exceeds the
maximally allowed movement speed of the robot, it will cause a kinematic error
during execution.

ol 1 Relative (base: X=0 mm, Y=0 mm, Z=0 mm, vel=50 mm/s, acc=40%, smooth=20%) P4
Type Parameters
Linear - Base %7 Velocity: 50.0 S mm/s Acceleration: 40 —% % Smoothing: 208 %
Offset
X: 00 mm A n/a Ext. axis 1:
X: 008 mm B: Ext. axis 2:
Z 00 8 {mm C Ext. axis 3:

Abort condition

False

Description
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“Linear - Tool":

A linear movement with an offset specified in Cartesian coordinates will be
performed. The coordinate system used for the offset are tool coordinates. The
movement speed is given by “Velocity”. It is measured in mm/s, if it exceeds the
maximally allowed movement speed of the robot it will cause a kinematic error
during execution.

= 1 Relative (tool: X'=0 mm, Y'=0 mm, Z'=0 mm, vel=50 mm/s, acc=40%, smooth=20%) 2
Type Parameters
Linear - Tool A Velocity: 50.0 'S mm/s Acceleration: 408 % Smoothing: 20K %
Offset
X' 00[S{ mm  A: Ext. axis 1:
N 00F${ mm B Ext. axis 2:
Z; 00/ mm C: Ext. axis 3:

Abort condition

False

Description
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86. GripperandDigital 10
86.1. Digitallnputs

Digital inputs and global signals are accessible as reserved words in conditional statements as
expressions in Section 4.1. For global signals these are GSigl, GSig2, ..., for digital inputs these
are Din1, Din2, ... . Depending on the state they will either evaluate to “True” or to “False”.

8.6.2. Digital Outputs

The Digital Output command canbe used to set the states of digital outputs and global signals.
=) 1 Digital Output (enable :DOut‘l') %

Parameters

-~

Channel type: |DOut ¥ | Channel ID: 1[5 State: [Enabled ~

Description

Under “Channel type” it is possible to specify if a digital output or a global signal are to be set.
“Channel ID" specifies the channel of the digital output or global signal. Under “State” the
desired state after execution of the command is specified. The command is accessible iniRC's
Program Editor by the menu entry “Action”->"Digital output”.
File Edit | Action| Flow Special
autoGen | # |Joint motion
& 0 | % |Linear motion 2
% |Relative motion »
¥

Variable motion »
% | Gripper

% |Digital output

8.6.3. Opening/Closing the Gripper

The Gripper command allows to control the gripper of the robot. It is accessible in iRC's
Program Editor by the menu entry “Action”->"Gripper”.

File Edit Action Flow Special
autoGen | % |Joint motion

s 0 % | Linear motion 2
Relative motion »

Variable motion »

¥
5
% | Gripper
'

Digital output
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You can set the desired aperture, measured in percent, under “Aperture”. A value of 0%
represents a fully closed gripper,100% represents a fully opened gripper. For grippers that can
only be either fully opened or fully close the threshold between these states is at 50%

apertu re.
= 1 Gripper (open gripper 0%)
Parameters
Aperture: o %
Description

87. Camera

=

We are currently working on this feature. The command specification will follow soon.
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9.  Stand-alone Operation with Embedded Computer
and the Operating Panel

To run the robot without a Windows PC connected, the Embedded Computer is necessary. It
runs the TinyCtrl software as Robot Control Software. The Embedded Computer allows to jog
the Gantry (using the Operating Panel), and to replay robot programs. To set up new programs
it is connected via Ethernet to a Windows Computer running iRC.

Programming Robot Control Motor Electronics Gantry Robot

Connected
via Ethernet

Embedded Computer Stepper and Gantry

iRC on Windows PC with Operating Panel Digital 10 Modules

Figure 9.1: Gantry with Embedded Computer as Robot Control.

This section shows how to operate the robot with Embedded Computer and Operation Panel.
After all electrical connections to the Robot have been established, the Robot has been
switched on and the Emergency Stop Button has been released, the errors first need to be

"reset" and then the robot needs to be "enabled".

When moving the Robot, always keep a hand on the Emergency Stop Button to prevent it from
hitting an object unexpectedly, for example if it is about to collide with the table.
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9..  ResetErrors/Enable Robot
On the touchscreen display,

press the "Enable" button in the upper menu (top
Status: ESTOP_NME_COM .
right) to get to the Enable page.

) Ref A2 U
O Resel o G0

0 Eiss 0
@ Enable

= Nowpress "Reset”

o The status changes to "MNE" (Motor Not Enabled)
o EEFH 0
@ ke o Q-

0 FiESN 0
@ Enable

= Press Encble

The status changes to "No Error”.
Stat_us: NoError " S
Motion:  OK Not ref'd!" (in red) means not referenced.

0 GEEFS 0
“ REseL Y oo

0 BEgal 0
@ Enable

9.2.  Movingthe Robot with the 3-Axis Joystick

Once the Robot is enabled, the axes of the Robot can be moved.

== s 1. Todo this, press the "Jog" button at the top of

the display
Sk . 2. PressAl
@ =@ Then move and turn the joystick.
@?” o @ You can now move the axes 1,2 and 3.
xvz m Ext. ABC
@ @ =@ 3. Press A4.
Now, move axes 4 and 5 by moving and rotating
the joystick.
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9.3. Referencing

4. Repeat steps2and 3until:

e theRobotisroughly ina"gallows position" and

o the"reference pin" (Fehler! Verweisquelle
konnte nicht gefunden werden. ) on the flange
of 5t axis points towards the Robot base.

To enable an automatic program sequence, the Robot electronics must be referenced.
The type of referencing movement depends on the Robot or encoder type.

3 @3 o
Status:  NoError
Motion:  OK

1 GEEY 1
@ R g

1 EisN 0
@ Enable

1. Todo this, press the square "Enable" button at
the top edge of the display.

2. The Robot must be in "NoError” status. If it is in
an error state, enable it by pressing the round
"Reset" button followed by the "Enable” button.

3. Now press the "Ref All" button to reference all
axes. The Robot now carries out search
movements for each axis.

4. Referencing is complete when there is a1 next
to Ref A1-ASrespectively.
For a 4-axis Robot, Ref A5 will remain at 0. Ref
E1is intended for additional external axes.

5. After referencing, the axes are in the error

state. This is necessary because the actual
position has changed in the referencing process.
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m 6. Now press the round "Reset" button, followed

by the round "Enable" button. The Robot is now

Status: NoError

Motion: referenced.

1 BEEYY 1
0 Reset

1 RSN 1

1 B2 0
@ Enable

9.4. Starting and Stopping a Program
= 1. Todothis, press the "Play" button at the top

] edge of the display and use the "prev" and
Status:  NoError
Motion: OK "next" buttons to select the
i : lgus5DOF. TestMotionprogram.

testmotion.xml -

O (\) O O O 2. Loadthe programusing the "Load" button

Single Play Cont. Play Pause Stop Load 3

Let the program play once using "Single Play".

4. "Cont.Play" plays the loaded program
continuously.

5. "Stop" stops the movement.

6. Theslider "Override" can be moved to the
right to increase the speed of the movement
or to the left to decrease it.

9.5.  Manually Setting the Digital Inputs/Outputs

The digital outputs can be activated and deactivated by pressing the illustrated switches.

o0 J-pis ] o If e.g. a gripper is connected to the DIO Module,

this can be activated or deactivated by switching
Status: NoError

Motion: theillustrated switches.
Dlgltal Outpula

Ofl o If asignal is present at the digital input, it will be
A displayed in the digital inputs field at the bottom
(C.\ t; Digital Inputs edge Of the dlsplay

(—‘/\gl D D D D D D D e The three buttons on the left side allow you to

switch between several DIO Modules.
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9.6.

Display of Status Information

Status information can be displayed by pressing the "Status" button at the top left corner of
the display.

Status:

Motion:

NoError
OK

Running (1/3)
testmotion.xml

Status:
Status:
Status:
Status:
Status:

V212

Temp: 41
Temp: 45
Temp: 58
Temp: 50
Temp: 38

The name of a program is displayed, e.g. while a
program is running.

The axis positions of axes 1-5 (or 1-4 for 4-axis
Robots) are displayed (A1-A5).

The temperature of the Stepper Modules is also
displayed.Due to the varyingloads on the individual
axes different holding currents are applied, which
lead to changing temperatures of the Stepper
Modules.

66



9.7.  Organize Programs on the Embedded Control

This iRC function is only available in combination with the Embedded Computer. When writing
programs on the Windows iRC software, these programs are automatically also downloaded
to the Embedded Computer.

With time there might be the necessity to re-organize these programs, e.g. to delete some of
them. This is possible with the “Manage Programs” icon in the “Motion" tab.

.
& 1 | - + 2> S oo WE x/ i\ &
Connect et E Reference Decrease Increase Motion Play St Replay Load Edit Clear] | Connect

Speed Speed  Type-~ Mode* Contro gra ‘lCon:rcﬂer

Figure 9.2:igus® Robot Control ribbon with "Manage programs" icon (circled in blue).
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10.

10.1.

Project Configuration

Program

With “Configure Project / Program” settings, the starting set up can be defined:

10.2.

File: which program to load during startup

File logic: which logic program to load during startup. The logic file runs parallel to the
main program allowing e.g. to set lights.

Override: the override (speed) that is set after startup.

Replay mode: the replay mode that is set after startup

iRC - igus® Robot Control - V902-11-005 - DLE-RG-000Lpsj

Project configuration

General File: ‘QBNWTEsumI ‘ ‘ sdmme‘
Wﬂl File logic: ‘r\/a ‘ ‘ sEAmme‘
E Overide: | »E]
:| Replay mode: @ Single () Repeat

1/0s

Figure 10.1: Configuration of the starting program in the backstage area.

Tool

With “Configure Project / Tool" settings, the tool attached to the Robot is chosen.
This setting changes the robot kinematic. Programs written using a different kinematic setting
cannot be replayed because this might lead to a collision.

iRC - igus® Robot Control - ¥902-11-005 - DLE-RG-0001.prj

Project configuration

General Tool type: ‘Hune -

Program

1/0s

i 10

Virtual Box

Figure 10.2: Configuration of the tool in the backstage area.

68



10.3. Inputs/Outputs

With “Configure Project / 1/0s" settings, the number of available inputs and outputs can be
configured and renamed. The corresponding names will show up in the Input/Output tab.

iRC - igus® Robot Control - V902-11-003 - RL-DP-5.prj - 0 x
@ Open project
- DOut T name: | | Dintname: | |
55 save projectas..
DOUt 2 name: | | Din2name: | |
&3 Reference robot DOut3 name: | | Din3name: | |
DOt 4 name: | | Dinaname: | |
DOt 11 name:
DOUt 12 name: |
DIN rail 1/0
) Configure Project Number of DIN rail modules: ‘1mudule v‘
= dule 1
{3} Configure Robot
DOut 21 name: B2t name: | Testin
Configure Interf
enure s . 22 e [
DOut 23 name: | DOut Din23name: | Din
(88 License
— —
¥ AboutiRC
DOut 25 name: | DOut Din25name: | Din
DOt 2R namar NOut Nin 24 nama: Din E
‘ Reset ‘ ‘ Apply ‘ Save project ‘
Set up your project.

Figure 10.3: Configuration of Inputs / Outputs in the backstage area.

For the Robot control, the "Base |/0" area is not used. Relevant is the "DIN rail /0" section.
The standard Robot Control comes with one DIO module with 7 inputs and 7 outputs. You can
define names for the I/O here.

If another DIO Module is added, then the setting has to be changed to “2 modules”, or
“3 modules”.

The settings are automatically synced with the Embedded Computer.
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10.4. Virtual Box

The “Configure Project / Virtual Box" settings allow to restrict the motion range of the Gantry.
These restrictions are monitored both, in linear and in joint motion.

This functionality assists to avoid mechanical damages. It is not a functionality
rated for personal safety!

s . e i Cora o - N |

oo oo

o A 510N Fil
s:q :@ b Ri m»% r‘” ) ) E
| positions  shapes | joint | trail Pa

Navigation Objects Preferences

igus Gantry
drylin-gantry\DLE-RG-0001.
Kinematic
oK

Virtual box
oK

Cycle
200+
max. 50.0 ms
Referencing

Not avalable.

Jogging | Input/Output | Programs & Variables

Figure 10.4: Gantry violating the virtual box.

In manual jogging mode an error message appears on the left side of the iRC window.
When running a program that violates the virtual box the program is stopped with an error
message.
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1. Robot Configuration

The Gantry Robots come with a standard set of parameters for the linear rail type and the
length of the different joints.

In Reality most gantries are custom made regarding the joint length. This joint length can be
configured in the Robot Configuration section.

iRC - igus® Robot Control - V902-11-005 - DLE-RG-0001.prj " o X

©

@ Open project

Robot configuration

antry

X axis length: 1140 s ¥ axis length: 642 H Z ais length: 1265
. ) [al .
X motion max: 800 S Y motion max: 500 Z motion max:

[F] save project

(2 Save project as..

&3 Reference robot

(D) Set joints to zer

¥ Configure Project

Configure Interfaces

{#8] License

¥ AboutiRC

Set up your robot. Click on 'Reload' to save the robot settings and reload the
current project.

Figure 11.1: Configuration of the joint length in the backstage area.

In the configuration both the joint length, and the motion range can be configured:
¢ Joint length: mainly used for visualization
e  Motionrange: Used to restrict the motion to avoid collisions

The motionrange has to be setaccording to the specific hardware setup. It depends on the joint

length, but also on the position of thereference pin as zero position, and additional components
like the energy chains.
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12.  Interfaces Configuration

121. Cameras

The iRC software has built-in support for receiving target positions from cameras. Currently
the IFM 02D is supported.

iRC - igus® Robot Control - V902-11-003 - RL-DP-5.prj - O X

(5 Open project

C IFM 02D NewC:
General

(2 save projectas.. PLC interface ] Enabled

Interface configuration

Name:
& Reference robot Desciption: [ ]
1P address: [ 192.168449 | port: | 50010 3]
Geometry
scaleX: | 4[5] scaley: | =S
OriginX: | 300[%] Origin¥: | of%] originz: | 4005
Look X: | 0}%{ Look ¥: \ 0|e{ Look Z: \ .ﬂe{
¢ Configure Project UpX: [ A vy | ofg] ez | o[Z
R Simulation
B Sim X: [ 0fg] simv. | ofg] simz | =)

Modelclass: | 5]

(8] License

v
¥ AboutiRC

‘ Reset ‘ ‘ Apply ‘ ‘ Save project |

Set up your interfaces.

Figure 12.1: Camera configuration dialog.

The work piece position reported by the camera can be accessed with the “Camera” command
in the robot program, see Section 8.7.
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12.2. PLCInterface

The PLC interface (PLC = Programmable Logic Controller) allows the integration of the Robot
into a production system controlled by a PLC. In this way, the Robot can work without manual
interaction. Also, it is possible to connect third party control panel with push buttons to
simplify and restrict operation of the robot in a production environment.

Specifically, this interface assigns certain digital |0 channels to special functions, such as:

non nmon

e inputs: "reset/enable motors", "start/stop program”, "reference”;

e outputs: "noFault", "enabled" and "program running".
Further details are available on the Wiki (section "PLC interface”, http://wiki.cpr-robots.com/).

12.3.  CRIEthernet Interface

The Commonplace Robotics Interface (CRI) allows the Robot to be controlled via Ethernet.
The Robot can be moved, programs can be uploaded and executed. It allows the development
of a custom robot control software. The control software (TinyCtrl) on the Embedded
Computer and igus® Robot Control on the Windows PC communicate via the CRl interface.

4

User

Application

User application as CRI client CPRog as CRI server, controlling a
Mover robot arm via USB

This interface makes it possible to combine the igus® Robot Control functions with
application-specific algorithms, such as a teleoperation system or a database. The CRI
documentation and a C# sample project for a client can be downloaded on request.
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13.  Troubleshooting

13.1.  Support Contacts

In case of problems we would be happy to help!
e igus support landing page: https://www.igus.de/info/robotics-low-cost-robotics
e Phone: +49(0) 2203-96498-255
e E-mail: ww-robot-control@igus.net
Please describe the problem briefly and send the file "logMessages.log"
from the folder C:\iRC-igusRobotControl\.

13.2.  Online Tool - Fault Identification and Recovery

Via the igus support landing page you have access to web pages that allow to:
=2 |dentify a problem based on user observations
= Propose solutions to the problem
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13.3.  Configuration of the Stepper Modules

The operating parameters of the Stepper Modules, particularly the motor currents, can be
adapted to the application. The Stepper Modules are delivered with a standard
parameterization for the specific Robot. Normally no change of the parameters is necessary.
If the Robot is to be operated at high loads or speeds, the motor currents can be increased.

This configuration can be done via the software tool "CPR ModuleCtrl". It can be downloaded
from the Wiki (http://wiki.cpr-robots.com/).

& CPR Module Control V03-010

X

Stat  Chat Corfiguration Abs Encoder TinyCid TorqueMotor Stepper

Read from Board Corfiguration TMC
SG Threshold [-64..63]
Configuration General (Higher is less curmrent)

[] Encoder (1) or StepCourt (0)
] Swap Encoder Direction {after Startup)

Cument Scale Load [0..31]

] End switch rising
[] Stop on End / Reference Switch

Curent Scale Start [0..31}
Curment Scale Idle [0..31]

Current Scale Ref [0..31]

100 000000 |-

[ Referencing: Straight ‘ | Sinus Ref Tics
[ Referencing: Sinus Sinus Ref Start Area

Pk . = Max Cycles

Referencing: Half
.—| Referencing Speed Min Supply Voltage
.— Offest at Endiwiich Max Temperature

Microstepping:
[[] Referencing: from both sides epna
| Ref Speed Siow
Write to Board
Log Messages

58:44:152 DEBUG cument directory: C:\CPRModuleControl\Program\Bin'x86
58:44:318 INFO  Changed Protocol to CPRCANV2

58:47:057 INFO  Position Control disabled

58:47:058 INFO  Disabling motion when chaning to StepperMotor tab

Figure 13.1: CPR ModuleCtrl Software, Stepper Motor Configuration Tab.

Figure 13.1 shows the configuration of the stepper motors. The behavior during referencing is
defined on the left side. Motor currents and microstepping are defined on the right side.
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o The Current Scale parameters define the max. current during normal operation (Load),
during the start-up phase (Start), at standstill (Idle) and during referencing (Ref).

o The Stepper Module uses Trinamic CoolStep technology to adjust the motor current
between these values and a lower limit value, which is a fraction of the Current Scale
value.

o Atlower Current Scale values, total power consumption and heat generation are lower.
However, a so-called "motor stall" can occur. In this case the current scale values must
beincreased.

o Athigher values, there is no motor stall, but the system becomes hotter.

e The current scale during the reference movement can be set separately to avoid damage,

e.g. by collision.

e The higher the microstepping, the smoother the movement. In operation without encoder
amicrostepping of max.1:64 should be used.

e ltispossibletoreversethedirection of rotation of the encoder. This change is applied after
the next cold start of the controller. If the encoder direction does not correspond to the
motor direction, the axis does not move correctly but accelerates until a position lag error
occurs. In this case, the encoder direction must be changed, and the system restarted.
The axis should then function properly.

13.4. Calibration of the Robot

The Gantry Robots are referenced using reference switches. For design reasons, however,
these are not exactly on the zero positions of the axes. The offset between reference switch
and zero position is stored in the EEPROM of the Stepper Modules.

If the Robot was supplied with the Robot Controller, these offsets are already set.

To perform the calibration yourself, you will find the necessary steps on the Wiki (section
"Define the Zero Position Offsets", http://wiki.cpr-robots.com/).
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13.5. Error Codes

The Robot Controller provides several status information:
e Status LEDs on the Electronic Modules.
e igus®Robot Control status information, received via CAN status bytes.

13.5.1. StatusLED of the Electronic Modules

Support Module:

Green LED on: Logic power supply on

Green LED flashing: CAN communication with the Support Module
Orange LED on: Error

Red LED on: Emergency Stop Button pressed

4

doy5-3
Jou3
NVD/-

8+80X0 QYD

Stepper Module:

6 mE Green LED on: Logic power supply on

g g 82 Green LED flashing: CAN communication with the Stepper Module
e Orange LED on: Reference switch is active

& Red LED on: Stepper Module is in error state or motor is not
L enabled

S%"  Digital In/Out Module:
oS % Green LED on: Logic power supply on
e b Green LED flashing: CAN communication with the DIO module
5 Orange LED on: The state of an input or output changes.
CE Red LED on: Error
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13.5.2. CAN-Bus andiRC Status Information

Bitin .

Error error byte Meaning Measures

Bus dead The CAN-Bus is not available. | Check the plug connections of the
Reasons are missing power power supply and the CAN line.
supply or missing plug Restart the control computer.
connections.

Temp Bit1 The temperature of the Motor | Check if the ventilation is installed
Modules is too high. and working. The motor current

may have to be reduced.

E-Stop/ Bit2 Emergency stop or voltage too | Check if the Emergency Stop

Supply low. Buttonis released.

MNE Bit3 No error. The motors arenot | Press the "Enable motors" button.

Motor not releasedyet.

enabled

CoM Bit 4 The time period without CAN | The position commands via the

Comm command from the controller | CAN-Bus must be sent in short

Watch was too long. intervals. Turn off other programs

Dog or update / virus scan functions.

LAG Bit5 Position lag error. The Robot | Decrease the speed of movement.

Position cannot maintain the target

Lag position.

ENC Bit6 Error in motor encoder or Check the encoder cables

Encoder absolute encoder

Error

0C Bit7 Overcurrent in the motors Reduce the motor current

Over

Current

DRV Bit8 Error in motor driver or motor | Drive specific

algorithm

After an "Error Reset" the normal status of the axes is 0x04 (motor not enabled).

After releasing the motors the status is 0x00, now the axes are ready for operation.
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